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Preface 

Thyroid hormones act on virtually any cell of the vertebrate organism. They play a 
central role in metabolic coordination and differentiation. Robust control of 
thyroid homeostasis is therefore essential for survival, differentiation and 
reproduction [1]. 
 
In 1936, only seven years after the discovery of the thyrotropic hormone TSH by 
Aron in the year 1929, Karl Fellinger suggested a negative feedback effect of 
thyroid hormones on thyrotropic cells of the pituitary [2]. W. T. Salter probably 
independently postulated the existence of a control loop linking the pituitary and 
thyroid gland in 1940. His idea was inspired by the then recent description of the 
two gonadotropic feedback control loops. Only a few years later, Astwood and 
Hoskins could reveal both the existence and the pathophysiological relevance of 
this thyrotropic feedback control system. In 1968, Panda and Turner succeeded in a 
quantitative description of the interdependence of thyroxine and TSH levels, but 
the first mathematical models of the feedback loop had already been developed up 
to 12 years earlier [3-6]. 
 
Over the years, cybernetic models of thyroid homeostasis were increasingly 
improved, a success that was enabled by improved mathematical modelling 
methodology as well as growing empirical data. As a consequence of this continued 
evolution some of the newest models are also suitable for medical decision-making 
[1, 7-11]. However, due to nonlinear interactions, none of these cybernetic models 
can simultaneously describe static and dynamic behaviour. This gap may be filled 
with computer simulations that additionally facilitate an intuitive insight into the 
dynamics of thyrotropic feedback. 
 
One of the more popular simulation programs for the pituitary thyroid feedback 
control is SimThyr. Based on a parametrically isomorphic model of the overall 
system [1, 12-15] SimThyr looks back on more than 25 years of continued 
development and a plethora of publications cited in PubMed and Web of Science 
[11-16]. Today, SimThyr is a user-friendly “virtual thyroid” program for modern 
desktop and server operating systems. Applications of SimThyr cover research, 
including development of hypotheses, and education of students in biology and 
medicine, nurses and patients. 
 
Software, source code and additional documentation of SimThyr are available from 
http://simthyr.sf.net. 
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Introduction 

SimThyr is a continuous simulator for pituitary-thyroid homeostasis. Pre-compiled 
Software is available for macOS (formerly referred to as Mac OS X or OS X), 
Mac OS Classic, Windows and ReactOS, but it can also be compiled for popular 
Linux distributions and several Unix derivatives. SimThyr was developed with 
Lazarus / Free Pascal (macOS, Linux, Windows and ReactOS) or THINK Pascal 
(Mac OS Classic), respectively. Source code is provided for all supported platforms 
and may also be used in order to compile SimThyr for additional platforms. 
 
This document describes the standard version of SimThyr for graphical user 
interfaces (GUI). Please refer to the handbook and reference information for 
SimThyr CLI for usage of the version for command line interfaces (CLI). 
 
 
System Requirements 
 
macOS / Mac OS X 
SimThyr 4.0 for Mac supports Mac OS X 10.4 (Tiger) or newer on systems with 
either Intel or PPC processors. Currently ARM processors (Apple Silicon) are 
supported via the Rosetta 2 engine. 
 
Windows 
SimThyr 4.0 for Windows has been developed for Windows XP and was 
successfully tested also on Windows 2000, Windows 7, Windows 10 and ReactOS.  
 
Mac OS Classic 
Mac OS Classic (6.0.7 or newer) is supported by the legacy version SimThyr 2.0 
only.  
 
Linux 
In order to use SimThyr on Linux please download the source code and compile it 
for your processor and operating system with Lazarus / Free Pascal. 
 
 
Installation 
 
For installing the program on Mac computers, simply drag the application file from 
the disk image (or BinHex package for legacy SimThyr 2.0) to the desired location 
on your file system. SimThyr for Mac doesn't come with and doesn't require an 
installer. 
 
The recommended way to install SimThyr on Windows-based computers is to use 
the provided installer. For special requirements, e.g. for installation on computers 
without administrative rights, a portable application is available, too. In order to 
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install the portable version simply drag the application file from the archive to the 
desired location on your file system. You may also start portable SimThyr directly 
from a USB stick, a CD and even a web server (depending on the settings of your 
browser). This may have advantages e.g. for CBT labs and other computer resource 
centres. 
 
On Linux, please download the source code and compile it for your processor and 
operating system with Lazarus / Free Pascal. 
 
 
Uninstalling SimThyr 
 
Before uninstalling SimThyr make sure that the application is not running. Then 
follow the directions of your operating system to delete the application file (on 
macOS this can be easily done by dragging the file representation to the trash can 
icon). 
 
As required you may also want to delete scenarios and preferences files. 
 
 
Source Code 
 
Source code is available from http://sourceforge.net/projects/simthyr. For 
compiling SimThyr from source please follow the directions given there.  
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SimThyr Guided Tour 

 
Starting SimThyr 
Start SimThyr by double-clicking its icon. After a short while a dialog box asking 
for simulation options is presented: 
 

 

 
 
 
 
First simulation 
For a first simulation run simply hit the Start button on the dialog box or press 
the Enter key on your keyboard. This will start a simulation of one day under 
standard conditions. 
 

 
 
The Log window shows simulated values of time and hormone levels. In the plot 
window results are presented graphically as time series. The small window titled 
“Prediction” displays predicted results from analytically solving the equations 
describing the feedback loop in a parametrically isomorphic model. 
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Small deviations from the depicted results above may ensue from simulated 
random effects. 
 
 
Experiment 1 
 
The first experiment simulates the development of subclinical (latent) 
hypothyroidism. 
 
In order to do this, first click the stop and reset button in the toolbar: 
 

 
 
 
 
This will delete all simulated values and set the time to zero. Then, start a new 
simulation over 14 days. Press the start button: 
 

 
 
 
 
and enter 14 days in the simulation settings dialog: 
 

 
 
After clicking “Start” you will obtain the result of 14 days in normal conditions that 
may be similar but not necessarily identical as depicted below. 
 

Stop and reset button 

Start button 
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Now, let’s develop subclinical hypothyroidism. In order to achieve this, click the 
start button again without hitting the stop button first. This will cause the 
subsequent simulation results to be appended to the previous results. 
 
In the simulation settings dialog don’t click the start button. Rather click on the 
button titled Structure parameters… in the middle of the lower part. This will 
open a new dialog enabling you to modify structure parameters of the overall 
feedback system. Here, change the thyroid’s secretory capacity (GT) to 1.2 
pmol/sec, i.e. you should enter 1.2E-12 into the field depicted GT. 
 

 
 

After clicking the OK button the new value for GT is stored. Then change the 
simulated time to 21 days to allow for enough settling time. After clicking Start 
you should receive results that are similar to the following: 
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Obviously, FT4 falls into the low-normal range while TSH oscillates between 
normal and elevated levels. 
 
In the structure parameters window you may change virtually every constant 
structure parameter of thyroid homeostasis including volumes of distribution, time 
constants and dissociation constants. Useful starting points for experimentation 
may be the sum activity of peripheral deiodinases (GD) and the secretory capacity 
of thyrotropic anterior pituitary cells (GH). 
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Experiment 2 
 
This simulates the effects of modifications in plasma proteins, e.g. in pregnancy or 
on anticonceptive medication. 
 
First, reconstruct standard conditions by clicking Standard in the structure 
parameters window and confirm with OK. Then, click the stop and reset button in 
the toolbar in order to delete all entries and start with time point 0. 
 
After clicking the start button you will get the already well-known simulation 
settings dialog. Here click on the radio box titled 50% TBG rise in the lower part 
of the window. 
 

 
 

To allow for the necessary settling times enter 30 days for total simulation and 7 
days as beginning of the effect. 
 

 
 
The results should be similar as depicted above, showing a decrease of FT4 levels 
in the beginning of the effect, than a short increase in TSH levels and a consecutive 
slight TSH decrease as FT4 rises in the achievement of a new equilibrium point. 
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You may change the combo boxes in the plot window in order to study the effects 
on other hormones of the feedback loop. 
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User Interface 

Toolbar 
Most functions of SimThyr are accessible from the toolbar. If you move the mouse 
cursor to a button and leave it there for a second without clicking, a small tool tip is 
displayed explaining its function. 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
  
 
 
  

Nullcline button: Provides a zero growth isocline plot visualising 
how settling points of thyroid homeostasis evolve. 

Simulation buttons (see below) 
Standard edit buttons for undo, cut, copy and paste. 

File buttons: Create, save and open files, e.g. scenarios, here. 

Stop and reset button: Stops a simulation and resets timers,  
if simulation was already stopped. 

Pause button: Suspends simulation. 

Run button: Starts a new simulation and resumes a suspended simulation. 

Parameters button: Modify structure parameters of 
feedback control here. 

IPS button: Displays information processing structure. 

Settings button: Set global application preferences here. 

Settings and scenario buttons (see below) 

TP button: Click here for getting a tornado plot, a special 
form of multi-way sensitivity analysis. 

TWSA button: Performs two-way sensitivity analysis. 

1WSA button: Perform one-way sensitivity analysis here. 

Sensitivity analysis buttons (see below) 
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Main Menu 
Additional options are available from the main menu. It will look slightly different 
on Mac OS, macOS (Mac OS X), Windows and Linux. However, the principal 
functions are identical. 
 

 
 
SimThyr menu: Application-wide options, e.g. Preferences and Services (macOS 
only) 
 
File menu: File- and scenario-wide options, e.g. for opening and saving files. 
 
Edit menu: Standardised editing options like cut, copy and paste. 
 
Simulation menu: Options for starting, stopping and suspending simulations as well 
as for changing structure parameters and for editing model annotations. 
 
Window menu: Select background or hidden windows here. 
 
Help menu: Help and additional information.  



SimThyr 4.0   Handbook and Reference 
 

  15 

Scenarios 

Simulation scenarios, e.g. containing a set of structure parameters in certain thyroid 
disorders, may be stored as XML files and reused. This may be a valuable option 
for research use, talks or educational purposes. Examples for useful scenarios are 
sets of structure parameters in certain thyroid disorders and influencing factors in 
some conditions like pregnancy or critical illness. 
 
Saved scenarios are also an excellent medium to make in-silico experiments better 
reproducible. An increasing number of journals requires submission of open 
scientific data as a supplement to submitted manuscripts. SimThyr supports this 
endeavour by delivering the foundations of a simulation experiment in form of an 
XML file, which is readable by both humans and machines. In order to make the 
files compliant to MIRIAM and MIASE statements, the required information may 
be entered in the model annotations window. 
 

 
 
Save a scenario by selecting the entry Save from the File menu and make sure that 
the format Scenario (XML) is selected in the save dialog. 
 
You can open and reuse an existing scenario by selecting Open Scenario… from 
the File menu. 
 
Scenario files are cross-compatible for all subversions of SimThyr 3.x and 4.x on all 
supported platforms. Despite the addition of additional information in SimThyr 4.0 
the file format is backwards-compatible to SimThyr 3.x. Scenario XML files created 
with the GUI version of SimThyr can also be read by the CLI version. 
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Sensitivity Analysis 

In its essence, cybernetic modelling maps a system’s structure onto its behaviour. 
This applies to both mathematical descriptions and simulation. A more methodical 
implementation of this approach is sensitivity analysis, a very powerful method in 
systems science. 
 
Sensitivity analysis systematically varies a structure parameter and investigates 
resulting behavioural variables. This helps to study the influence of certain marginal 
conditions on relevant output variables and to define factors that are critical for 
definite wanted (or unwanted) results. Additionally, this method allows assessing 
how the uncertainty of behavioural variables can be apportioned to different 
sources of uncertainty in model input. 
 

  
One-way sensitivity analysis Tornado Plot 

  

  
Two-way sensitivity analysis Zero growth isocline plot 

 
One-way sensitivity analysis, two-way sensitivity analysis, tornado plots and 
nullcline plots (equilibrium diagrams) may be accessed from the Simulation menu. 
Usage should be self-explanatory. In any case of classical sensitivity analysis select 
independent structure parameter(s) and dependent behavioural parameter(s) (i.e. 
hormone levels). In null isocline plots select two hormones, the interaction of 
which you want to study. The resulting plots may be modified with respect to 
colour and (for one-way and two-way sensitivity analysis) for lower and upper 
boundaries of structure parameters. 
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Table 1: Forms of sensitivity analysis provided by SimThyr 
 

Form of sensitivity analysis Kind of relation Comments 
One-way Multivariate (one independent 

and n dependent variables) 
Maps selected hormone 
concentrations to one structure 
parameter of feedback loop. 

Two-way Bivariable (two independent 
and one dependent variables) 

Maps a selected hormone 
concentration to two structure 
parameters of feedback loop. 

Tornado plot Multivariable (n independent 
and one dependent variables) 

Maps a selected hormone 
concentration to fixed changes 
of an arbitrary number of 
structure parameters. 

Nullcline plot Bivariable and bivariate Maps the interaction of two 
hormone concentrations to 
visualise the evolution of an 
equilibrium point. Also referred 
to as interaction plot, null 
isocline plot or zero growth 
isocline plot. 
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Preferences 

Global application preferences allow for setting units of measurement and number 
formats for all your simulations. 
 

 
The flexible modular menu structure enables you to compose virtually every 
imaginable measurement unit. Your entry is parsed and automatically converted to 
correct conversion factors. 
 
Number formats are also very flexible. You may specify Free Pascal-style format-
strings to set the number of digits and type of notation: 
 
0: Digit place holder. The digit of the corresponding place in the number will 
replace 0, otherwise a missing digit is filled with 0. 
#: Digit place holder. A digit in the value will replace the corresponding #, a missing 
digit is replaced by a space. 
.: Location of decimal separator 
,: Location of thousands separator 
E+, e+, E- and e-: Scientific notation. # signs after E+ denote the number of 
places. 
; Separates positive, negative and zero numbers, respectively. 
 
Examples: 
 
###,###.00##: 1,234.50 
######.0: 1234.5 
#.###E+: 1.235E+5 
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Date formats may be specified with format strings, too: 
 
D: day 
dd: day with leading zero 
h: hour 
n: minute 
s: second 
 
Examples: 
 
"d"D hh:nn:ss: d1 03:31:40 
hh:nn “h”: 03:31 h 
 
 
 
Supported File Formats 

SimThyr supports export of simulation results in various formats including tab-
delimited, CSV and DIF files. Both tab delimited and CSV are simple table 
formats, where columns (i.e. different simulated parameters) are separated by 
tabulator or comma signs and points in time are delimited by carriage return or 
linefeed symbols (depending on platform conventions). DIF (data interchange 
format) is a standard for a neutral representation of contents that facilitates the 
transfer of data among various applications. All of the mentioned formats are 
supported by a wide range of database, statistics and spreadsheet applications. 
 
Plots may be saved in multiple varieties of image formats including bitmap (BMP), 
pixmap (XPM), portable pixmap (PPM), joint picture expert group (JPEG) format, 
tagged image file format (TIFF), portable network graphic (PNG) and, with some 
restrictions, scalable vector graphic (SVG). 
 
Scenarios and preferences are saved as XML files. 
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